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READ CAREFULLY BEFORE USING

Canon Software License Agreement
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS BOX.
BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.
This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE
SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE DATA) AND THE USER
MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE”) AND PROMPTLY RETURN THE SOFTWARE TO
YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.
1. LICENSE:  Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a single

computer.  You may physically transfer the SOFTWARE from one computer to another provided that the
SOFTWARE is used on only one computer at a time.  You shall not install or use the SOFTWARE on a
network, multiple CPU, multiple site arrangement, or any other hardware configuration where the
SOFTWARE is accessible to more than one CPU or to more than one user.
With respect to the sound and image data (“Data”) contained in the Software, which are to be downloaded
to the applicable Canon digital camera product, Canon grants you a personal, non-exclusive license to use
the Data on a single Canon digital camera product only.
YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER,
MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up purposes, or copy the
SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the original for
back-up purposes.  Any other copying of the SOFTWARE is a violation of this Agreement.  You must
reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES:  Neither Canon, nor its subsidiaries, dealers or distributors will be responsible for
providing maintenance or support for use of the SOFTWARE.  No updates, fixes or support will be made
available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose, maintain and
match the hardware and software components of your computer system.  Thus Canon does not guarantee
uninterrupted service or correction of errors or that the functions or performance of the SOFTWARE will meet
your requirements.  THE SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND WITHOUT WARRANTY OR
CONDITION OF ANY KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized Canon dealer as
evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same
without charge when returned by you at your expense to your point of purchase and proven to be defective
upon inspection.  The Replacement CD-ROM will be warranted for the remainder of the original ninety (90)
day warranty period of the defective CD-ROM.  The limited warranty does not apply if the failure of the CD-
ROM resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to anyone other
than the original user of the SOFTWARE.
EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S SUBSIDIARIES,
DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING ANY WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE FOR
ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT,
CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR
INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL HAVE
ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A THIRD PARTY
ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY
OF SUCH THIRD PARTY.
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SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM NEGLIGENCE ON
THE PART OF THE SELLER, SO THE ABOVE DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY TO
YOU.

5. TERM:  This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of
all copyright interests in the SOFTWARE unless earlier terminated.  You may terminate this Agreement by
destroying the SOFTWARE.  This Agreement will also terminate without notice to you if you fail to comply
with any of the terms of this Agreement and you must then promptly return the SOFTWARE.  In addition,
Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:
The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995), consisting of
“commercial computer software” and “commercial computer software documentation,” as such terms are
used in 48 C.F.R. 12.212 (Sept 1995).  Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through
227.72024 (June 1995), all U.S. Government End Users shall acquire the SOFTWARE with only those rights
set forth herein.  Manufacturer is Canon Inc./30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501,
Japan.

7. EXPORT RESTRICTIONS:  You agree to comply with all export laws and restrictions and regulations of the
country involved, and not to export or re-export, directly or indirectly, the SOFTWARE in violation of any such
laws and restrictions and regulations, or without all necessary approvals.

8. SEVERABILITY:
In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal of
competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or
tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

9. CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the Software in the United
States of America shall be governed and construed in all respects in accordance with the laws and
regulations of the State of New York, without reference to choice of law principles.  The terms of this
Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of the
province of Ontario.

10.OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE
belong to Canon, its affiliated corporations and third party licensors.  Your use of the SOFTWARE is subject to
the laws of the United States, and Canada, and other applicable copyright and trademark laws, and nothing
in this Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party
licensors under such laws.  You only own the CD-ROM media in which the Software is stored.  Except as
expressly provided herein, no license or right, express or implied, is hereby conveyed or granted by Canon to
you for any intellectual property of Canon.  Nothing contained in Paragraph 1 shall be construed to give
Canon any ownership rights in any images, graphics or textual material that you save in connection with the
Software.
You may not modify, remove or delete any or all copyright notices (i) which are contained in the Software,
including any copy thereof, and (ii) which are on the original CD-ROM and on the medium of a back-up copy
made pursuant to Section 2 above.

11.ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ
THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF
AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND
SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF.  NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED
OFFICER OF CANON.
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Read This First

You can connect a camcorder to the computer using a USB cable to download
still images recorded on the memory card of the camcorder. You can also use
the provided software to sort, store, and print still images.

Disclaimer
• While every effort has been made to ensure that the information contained

in this guide is accurate and complete, no liability can be accepted for any
errors or omissions. Canon reserves the right to change the specifications of
the hardware and software described herein at any time without prior
notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in
a retrieval system, or translated into any language in any form, by any
means, without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost
data due to mistaken operation or malfunction of the camcorder, the
software, memory cards (MultiMediaCards or SD Memory Cards), personal
computers, or peripheral devices, or due to use of a memory card not
formatted by a Canon camcorder.

Trademark Acknowledgments
• Canon is a registered trademark of Canon Inc.
• Macintosh is a trademark of Apple Computer Inc., registered in the United

States and other countries.
QuickTime is a trademark of Apple Computer, Inc.

• Microsoft®, Windows® and Windows Media® are either registered
trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries.

• Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.

Copyright © Canon Inc. 2003 All rights reserved.

Safety Precautions
Do not play the supplied CD-ROM(s) in any CD player that does not support
data CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player)
could damage the speakers. It is also possible to suffer from hearing loss from
listening with headphones to the loud sounds of a CD-ROM played on a
music CD player.
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Checking Supplied Accessories
Use the following accessories to download recorded images from a memory
card to your computer.
• IFC-300PCU USB Cable

• DIGITAL VIDEO SOLUTION DISK

• Windows users: Move on to p. 8.
• Macintosh users: Move on to p. 60.

The explanations in this manual use mainly Windows 98 and Mac OS 9.2
screen shots.

Download from Www.Somanuals.com. All Manuals Search And Download.
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Windows  System Requirements

❍ The USB interface is only supported for those computers that come
with Windows 98/Windows Me/Windows 2000/Windows XP
preinstalled and have built-in USB ports.

❍ Proper operation is not guaranteed on a dual CPU PC or on a user-
built PC.

❍ Proper operation is not guaranteed on any particular system, even if
it meets the requirements outlined above.

❍ A CD-ROM drive is required to install the software.
❍ Connect the USB cable directly to one of the computer’s main USB

ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

❍ The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

❍ Do not connect two or more camcorders to the same computer via
the USB interface. The connections may not operate correctly.

❍ Not all operations performed with a connection to a USB 2.0
compatible board can be guaranteed.

Please install the software on a computer meeting the following minimum
requirements.

OS: Windows 98 (First or Second Edition)
Windows Me
Windows 2000
Windows XP (Home Edition, Professional)
* Proper operation is not guaranteed on an OS that

has been upgraded from a previous version.
Computer Model: Computers that come with above OS preinstalled

and have built-in USB ports.
CPU: Windows 98/Windows Me/Windows 2000: Pentium

150 MHz or better
Windows XP: Pentium 300 MHz or better

RAM: Windows 98/Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more

Interface: USB: only preinstalled Windows 98/Windows Me/
Windows 2000/Windows XP systems with built-in
USB ports

Free Hard Disk Space: • Canon Utilities
– ZoomBrowser EX: 120 MB or more  (Including the

PhotoRecord printing program)
– PhotoStitch: 40 MB or more

• Canon Camera TWAIN Driver: 25 MB or more
• Canon Camera WIA Driver: 25 MB or more

Display: 800 × 600 pixels/High Color (16 bit) or better,
1,024 × 768 pixels or better is recommended

Download from Www.Somanuals.com. All Manuals Search And Download.
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What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained
on the DIGITAL VIDEO SOLUTION DISK.

■ TWAIN Driver (  14)
TWAIN Driver is the driver software for Windows 98 and Windows 2000
that is required for downloading still images/movies from a memory card to
a computer.

■ WIA Driver (  15)
WIA Driver is the driver software for Windows Me and Windows XP that is
required for downloading still images/movies from a memory card to a
computer.

■ ZoomBrowser EX (  17)
• Downloading still images/movies from a memory card to your computer.
• Categorizing and organizing large volumes of images.
• Creating mail attachments from images. (Your e-mail program needs to

be enabled as MAPI client.)

■ PhotoRecord (  33)
• Laying out and printing still images.
• Printing indexes.
• Creating still image albums.

■ PhotoStitch (  41)
Merging Panoramic Images.

This instruction manual explains how to install the software, what you can do
with the main features and how to operate them. For more detailed
perational instructions, refer to the Help menu of each software program.

Download from Www.Somanuals.com. All Manuals Search And Download.
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Installing the Software

Installer Panel

Installing from the DIGITAL VIDEO SOLUTION DISK

❍ Before you attach the camcorder to the computer with the USB
cable for the first time, you must install one of the following drivers
onto the computer.
Windows 98/Windows 2000: TWAIN Driver (  14)
Windows Me/Windows XP: WIA Driver (  15)

❍ Users of Windows 2000 or Windows XP must first log in as an
Administrator to install programs.

1. Close any programs that are running.

2. Set the DIGITAL VIDEO SOLUTION DISK in the computer’s CD-
ROM drive.
• The installer panel opens automatically.
• If the installer panel does not appear automatically, use the following

procedures to display it.
Windows 98, Windows Me, Windows 2000:

1. Double-click the [My Computer] icon.
2. Right-click the CD-ROM icon and select [Open] from the displayed

menu.
3. Double-click the [Setup.exe] icon.

Windows XP:
1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open] from the displayed

menu.
3. Double-click the [Setup.exe] icon.

Depending on the setting of your computer, the file extension “.exe”
may not appear.

3. Select your language.

4. Click [Digital Video Software Installation].

Download from Www.Somanuals.com. All Manuals Search And Download.
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5. Click [Next].

6. Read the license agreement and click [Yes].

7. Confirm the installation destination and click [Next].
Normally, select (C:\Program Files\Canon).

8. Select the programs you wish to install and click [Next].
Confirm that there is a check mark beside the name of the program you
wish to install.

Download from Www.Somanuals.com. All Manuals Search And Download.
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9. Select your camcorder model name and click [Next].
Place a check mark beside your camcorder model name.

10.Review the installation settings and click [Next].
Installation starts.

11.When the following window appears, click [OK].
This window only appears if you installed the TWAIN Driver or the WIA
Driver.

Installing the Software
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12.When installation is complete, select [Yes, I want to restart
my computer now.] and click [Finish].

13.When the computer has restarted and the regular desktop
screen is displayed, remove the DIGITAL VIDEO SOLUTION
DISK from the CD-ROM drive.

❍ When installation is complete, remove the DIGITAL VIDEO SOLUTION
DISK before you connect the camcorder to the computer.

❍ At this point, the files for the TWAIN Driver or WIA Driver have only
been copied to your computer. To download still images/movies via
USB connection, finish installing the TWAIN driver or the WIA driver.

Download from Www.Somanuals.com. All Manuals Search And Download.
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Installing the Software

Installing the TWAIN Driver/WIA Driver
When you have installed the software from the DIGITAL VIDEO SOLUTION
DISK, go on to install the TWAIN Driver or the WIA Driver.

TWAIN Driver
TWAIN Driver is the driver software for USB connection to Windows 98 and
Windows 2000 that is required to download still images/movies into
ZoomBrowser EX.

Users of Windows 2000 must first log in as an Administrator to install
the driver.

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  16).
• After a few moments, a message such as “New Hardware Found”

appears and the TWAIN driver will be installed automatically.
• If you are prompted to restart the computer, restart the computer.
• When installation is complete, a window appears allowing you to select

an application program to start.
See Downloading Still Images/Movies  (  17) for how to start
ZoomBrowser EX and download still images/movies to the computer.

Windows 98/Windows 2000
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WIA (Windows Image Acquisition) Driver
WIA Driver is the driver software for USB connections to Windows Me and
Windows XP that is required to download still images/movies into
ZoomBrowser EX.

❍ Read carefully before installing the WIA Driver:
When you have set the WIA Driver to start a particular application
program when you connect the camcorder, the program may cause
an error message similar to the following to appear: “TWAIN data
source not found. Reinstall the scanner software.” If this happens,
select [WIA-camera model] in the application program as the TWAIN
device.

❍ Users of Windows XP must first log in as an Administrator to install
the driver.

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  16).
• After a few moments, a message such as “Found New Hardware”

appears and the WIA driver will be installed.
• If you are prompted to restart the computer, restart the computer.
• Windows Me: When installation is complete, the Scanners and Cameras

Wizard starts.
See Downloading Still Images/Movies (  18) for how to start
ZoomBrowser EX and download still images/movies to the computer.

• Windows XP: When installation is complete, a window appears
allowing you to select an application program to start.
See Downloading Still Images/Movies (  17) for how to start
ZoomBrowser EX and download still images/movies to the computer.

Windows XP: If a window appears prompting you to select an
application program to start, select ZoomBrowser EX or Scanners and
Cameras Wizard to start. If neither of these is selected, operation may
not work correctly. You can also set the computer to start ZoomBrowser
EX or Scanners and Cameras Wizard automatically (  52).

Windows Me/Windows XP
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❍ Make sure the camcorder is being powered using the power adapter
before connecting it to a computer.

❍ Be sure to install the DIGITAL VIDEO SOLUTION DISK before you
connect the camcorder to the computer.

❍ Connect the USB cable directly to one of the computer’s main USB
ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

❍ The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

❍ Do not connect two or more camcorders to the same computer via
the USB interface. The connections may not operate correctly.

❍ Never allow the computer to go into standby (sleep) mode while
a camcorder is connected via the USB interface. If it does happen,
never disconnect the USB cable. Try to awaken the computer with
the camcorder in the connected state. Some computers will not
awaken properly if you disconnect the camcorder while they are
in standby mode. Please refer to your computer manual for
instructions regarding its standby mode.

1. Insert a memory card into the camcorder.

2. Connect the power adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
• You do not need to turn off the computer for this procedure.
• Refer to your computer manual for the location of the computer’s USB ports.
• See your camcorder instruction manual for connecting instructions.

Connecting the Camcorder to a Computer

USB Cable

Camcorder End Computer End

USB Terminal
on the Camcorder

USB Port on 
the Computer

The first time you connect the camcorder to the computer via USB
interface, install the TWAIN Driver or the WIA Driver (  14,15).

Download from Www.Somanuals.com. All Manuals Search And Download.
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Below explains the procedure for connecting a camcorder to a computer using
the USB cable. For connecting a PC card reader/writer, see Using a PC Card
Reader/Writer (  21).

❍ Observe following precautions when the camcorder’s card access
indicator is flashing (the camcorder is reading or writing from or to
the memory card). Failure to do so may cause memory card data to
become corrupted.
–  Do not remove the memory card or detach the USB cable.
–  Do not turn off the camcorder or the computer.
–  Do not change the position of the POWER switch or the TAPE/

CARD switch.
❍ Format the memory card with the camcorder or from the Camera

Window (  23).
❍ Still images/movies recorded onto the memory card or downloaded

to the hard disk are important original data files. Create a copy of
the file first before working on it on your computer.

❍ When an enormous volume of still images/movies (such as 500 or
more) is recorded onto one memory card, transferring them to a
computer may take very long.

❍ For Windows XP Users:
Do not rotate the image in the [Windows Picture and Fax Viewer] or
in the explorer view. The file format of the original image will be
changed and the image can no longer be displayed in ZoomBrowser
EX or on the camcorder.

For instructions on how to set ZoomBrowser EX to start automatically,
see page 50.

Downloading Still Images/Movies (ZoomBrowser EX)

Starting ZoomBrowser EX

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

Windows 98/Windows 2000/Windows XP
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Downloading Still Images/Movies (ZoomBrowser EX)

4. Connect the camcorder to the computer using the supplied
USB cable (  16).
After a few moments, a window appears allowing you to select an
application program to start.

5. Select [Canon ZoomBrowser EX] and click [OK].
• ZoomBrowser EX starts and opens the Camera Window, displaying the

camcorder images as thumbnails (small images).
• If a camcorder and PC card reader are connected at the same time, a

window appears allowing you to select the camcorder model. Confirm
that your camcorder model name is displayed and click [OK].

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  16).
The Scanners and Cameras Wizard automatically opens. Click [Cancel] to
close the Wizard.

5. Double-click the [ZoomBrowser EX] icon on the desktop.
ZoomBrowser EX starts and the Main Window appears.

Windows Me
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6. Click [Camera & Memory Card] in the Main Window.

7. Click [Browse and Download Images].
The Camera Window opens, displaying the memory card images as
thumbnails (small images).

Downloading Still Images/Movies to the Computer

1. In the Camera Window, select the still image/movie you
wish to download and click [Download image].
• An orange frame appears around the selected still image/movie.
• You can select multiple images by continuously clicking on the images.

Click on the image again to deselect.
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2. In the Download Settings window, confirm the settings and
click [OK] (  23).

The Camera Window closes and the Main Window opens. The
downloaded images appear in the Main Window.

Downloading Still Images/Movies (ZoomBrowser EX)
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Using a PC Card Reader/Writer

This section explains only the instructions which differ when connecting a PC
Card Reader/Writer instead of the camcorder.
For instruction on how to connect the PC Card Reader/Writer, please refer to
its manual.

1. Insert a memory card into the reader.

2. Windows 98/Windows 2000/Windows Me: Double-click the
[ZoomBrowser EX] icon on the desktop.

Windows XP: When a window appears allowing you to
select an application program to start, select [ZoomBrowser
EX] and click [OK].
ZoomBrowser EX starts.

3. Click [Camera & Memory Card].

4. Click [Browse & Download Images].
• The Camera Window opens, displaying the memory card images as

thumbnails (small images).
• If multiple PC card readers loaded with memory cards are connected or

if a camcorder and a PC card reader are connected, a selection dialog
will appear before the Camera Window opens. Select one of the
devices to proceed and click [OK].
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Using Other ZoomBrowser EX Functions

Camera Window
The Camera Window opens when a connection to a camcorder is initiated.
Still images/movies will be displayed as thumbnail (small) images (Movies are
displayed with the first scene as a still image, indicated with a movie icon).
Buttons are activated when a still image/movie is selected.

Task Area

[Download image]: Downloads selected still images/movies to the
computer.

[Print]: Prints selected still images. Menu options: Layout
Print and Index Print.

[View as slideshow]: Starts a slide show after downloading the selected
still images/movies to the computer.

[Connect to Internet]: Attaches selected still images to an e-mail message.

Toolbar

[Set]: Adjusts the connection settings and camcorder settings. Menu
options: Reconnect, Camera Settings, Slide*/DPOF, Add Image(s) and
My Camera*. (*The SLIDE/My Camera (  47) function cannot be used.)

[Select]: Selects still images/movies. Menu options: Select All, Select
New, Select Print mark, Select Send mark, Select Slide Show
mark and Invert Selection.

[Deselect]: Deselects still images/movies.
[Rotate]: Rotates still images. Menu options: 90 degree left, 90 degree

right and 180 degree.
[Delete]: Deletes selected still images/movies.
[Properties]: Displays image information (such as shooting date/time and

image size).
[Help]: Displays help topics.

Thumbnails
Still images and movies are 
displayed in reduced size.

Indicates that it has been 
downloaded to a computer.

Task Area Toolbar
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Camera Settings Window
You can adjust the date, time and owner settings in the Camera Settings
window using the computer when the camcorder is connected. You can also
check the battery charge and remaining memory card capacity.

1. In the Camera Window, click the [Set] button and select [Camera Settings]
from the displayed menu.

2. Check or change the settings.
Click [OK] to close the window.

Download Settings Window
The following window appears when you select a task in the Task Area of the
Camera Window.

Select a folder in which you wish to 
download and save the still image/movie.

If you wish to create a new folder, select 
[Create new folder] and select the item 
you wish to use as folder name.

If you leave the box without check mark, 
the folder will be named in the form of 
“100-0001.JPG”.
If you put a check mark in the box, you 
can designate a file prefix. The folder will 
be named “file prefix + 0001.JPG”.

Input a camcorder owner name here 
(up to 31 characters).

Set the date and time here.

Click this button to synchronize the 
camcorder to the computer’s date 
and time settings.

Check the battery status here.

Click this to format the memory card 
in the camcorder. 

Check the remaining memory card 
capacity here.
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Using Other ZoomBrowser EX Functions

Main Window
ZoomBrowser EX's Main Window features various buttons and an image
display area. This section introduces the names and functions of the various
window parts.

Task Area (Main Menu)

[Camera & Memory Card]: Displays the Camera Window.
[Print]: Prints selected still images. Menu options: Layout

Print and Index Print
[View & Modify]: Use this to view or edit images. Menu options:

View as a Slide Show, Edit Image and Stitch
Photos.

[Internet]: Attaches selected still images to an e-mail
message.

Task Area

Toolbar

Folders Area
Select image folders here. As in 
Windows Explorer, you can view 
the contents of the folders.

Browser Area
Displays the images 
contained in the 
selected folder.

Clicking      hides the area. 
Click     again to redisplay the area.
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Toolbar

[View Mode]: Switches between the Zoom Mode and Scroll Mode.
Scroll Mode:
Displays the images in the selected folder at a large, easy-
to-view size. When there are more images than can fit in
the Browser Area, a scroll bar appears at the right of the
Browser Area. When a folder has been created within the
selected folder, the folder appears as an icon.
Zoom Mode:
When a folder has been created within a folder, it displays all
images within the nestled folder. Selecting the magnifying
glass (+ or –) and clicking a folder or an image in the Browser
Area changes the size at which an image is displayed or the
folder level. You can also zoom up by double-clicking an
empty part of the Browser Area or the tab of a folder name.

[Thumbnail Size]: Selects the size at which images are displayed in the Browser
Area. Menu options: 80 × 80, 160 × 160 and Column Number.
It can only be selected in [Scroll Mode].

[View Image]: Displays a still image in the Image Viewer window, or
opens a window for playing back a movie.

[Properties]: Displays image information (such as shooting date/time
and image size).
If you select an image in the Browser Area while the
Properties window is open, the information in the window
switches to the contents of the selected image.

[Rotate]: Rotates selected still images.
[Delete]: Deletes selected still images/movies.

Switch between images with 
this button when more than 
one image is selected.

You can change the file name 
or enter a comment.
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Image Viewer Window
The Image Viewer window appears when you double-click a still image, or
when you select a still image and click [View Image].

Using Other ZoomBrowser EX Functions

Color, Brightness and Contrast
You can adjust the color, 
brightness and contrast by 
dragging the respective slide.

Zoom
You can change 
the zoom ratio.

Crop
You can extract a part of the image.
1. Click on the image and drag to form a rectangular frame. 

You can move or change the size of the frame.
2. Click this button to extract the area within the frame. 

The extracted part of the image appears. 
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Playing Back Movies From a Memory Card

In the Camera Window and Main Window, movies are displayed with the first
scene as a still image with a movie icon (  ). When you double-click the
thumbnail in the Main Window, QuickTime Player starts and plays back the
movie.

❍ If QuickTime 3.0 or a later version is not already installed on your
computer, install the QuickTime 5.0 program from the DIGITAL
VIDEO SOLUTION DISK.  Place the disk in the CD-ROM drive and
click [QuickTime 5.0 Installation] in the installer panel.

❍ Do not double-click a movie file (.AVI extension) in Windows
Explorer.  That will start Windows Media Player, which may not
support this file type. To play back movies, double-click the
thumbnail with a movie icon in the Main Window’s Browser Area.

1. In the Main Window, double-click a thumbnail with a 
(movie) icon.
QuickTime Player starts.

2. Click the e (play) button in QuickTime Player.
The movie will be played back.
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Running a Slide Show

You can view selected still images in a slide show. Movies cannot be selected
for a slide show.

1. Click [View & Modify] in the Main Window.

2. Click [View as a Slide Show].

3. Select the images and select [Setup Slide Show].
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4. Select the slide show settings.

• [Image Size]: Select the size of the still images.
• [Image Information]: Select to show image information such as file

name or title.
• [Advance to Next Slide]: Select to advance manually or automatically.

When you select “Every 3 seconds”, you can select the interval in the
control below (from 1 to 120 seconds).

• [Loop]: Select to stop the slide show after the last image or to
continuously run it in a loop.

• [Effect]: Select the transition effect to be used when moving from one
slide to another. When you click an effect, you can check the effect in
the preview window.

5. Click [Start Slide Show].
Click  in the lower right corner to end the slide show.
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Attaching Still Images to E-mail Messages

You can attach selected still images to an E-mail message.

To use this function, the e-mail program must be enabled as MAPI
client. For details, refer to the instruction manual of the e-mail
software.

1. Click [Internet] in the Main Window.

2. Click [Email Images].
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3. Select the images you wish to send in the Browser Area and

click [Change Image Size].
You can select multiple images by continuously clicking on the images.
Click on the image again to deselect.

4. Select image size and quality, and click [Send or Save].
• If you wish to send the image without changes, select [Send images

unchanged]. Normally select [Resize and compress images into JPEG
format].

• [Resize Image]: Select the reduction ratio to the original image.
• [Image quality]: The lower the quality, the coarser becomes the image

and smaller the file size.
• Pressing [Apply] displays the file size after the compression as [Total size

of changed images].
• You can check the compressed image by pressing [View Images].
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5. Select to send images by e-mail or to save the images in a
folder and click [Finish].
• If you selected [Create a new email], your e-mail program starts and the

selected images appear as an attachment in the message window. Input
address, subject and your comments and send the message. E-mail
programs not supporting MAPI do not start automatically. In this case,
go back to step 5 and select [Save the images in a folder...].

• If you select [Save the images in a folder...] click [Browse] and select the
destination folder. Start your e-mail program and attach the saved
image to a message.

Attaching Still Images to E-mail Messages
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Printing Still Images (PhotoRecord)

PhotoRecord is a printing program. You can use this program to lay out the
still images for printing. You can also create original albums and save them to
your computer.

❍ Do not remove the memory card, detach the USB cable or turn off
the camcorder while data is being transferred to the printer (when
the camcorder’s card access indicator is flashing). Doing so may
cause memory card data to become corrupted.

❍ If you are using a network printer and the printer name (including
the network path) exceeds 31 characters, it may not be possible to
print from PhotoRecord. If this happens, open [Control Panel] on the
[Start] menu. Click the [Printers] icon and change the name of the
your printer, limiting its length to within 31 characters.

Movies cannot be printed.

1. Click [Print] in the Main Window.

2. Click [Layout Print].
When you have selected [Index Print] and click [Open Index Print], the
Index Print Settings window appears. Select paper size and other settings
and click [Print] to start printing.
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Printing Still Images (PhotoRecord)

3. Select the still image you wish to print and click [Captions
for Printing].
You can select multiple images by continuously clicking on the images.
Click on the image again to deselect.

4. Select the image information you wish to include in the print
and click [Open Layout Print].
• Place a check mark beside the items you wish includ in the print.
• If you wish to add a comment, right-click the mouse button on the still

image, select [Properties] from the displayed menu and type in a
comment.

• PhotoRecord starts and the PhotoRecord Print Modes window appears
(  36).

5. Select a print mode and click [Next].
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6. Select paper size and other settings and click [Next].

7. Select [Automatic Layout] and click [Finish].
The PhotoRecord window appears. If you wish to change the layout,
select the layout in this window.

8. Click [PRINT] in the PhotoRecord window.
• The Print window appears.
• If you wish to save it as an album, select [Save As] from the [File] menu,

select the destination folder and input the file name.

9. Click [Print] in the Print window.
Printing starts.
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Printing Still Images (PhotoRecord)

Selecting the Print Layout and Album Design
The PhotoRecord Print Modes window appears when you perform the steps 1
to 4 above or when you click [PRINT MODES] in the PhotoRecord window. Use
this window to select print layout or album design.

1. Select the print mode.
• The available print modes options depend on the printer you are using.
• When you click [Next], a window for selecting the paper size appears.

Artwork/Layout album
You can create a colorful 
and fun design.

Fixed photo size printing
You can squeeze pictures 
into the paper size for printing.

Tiled photo printing
The program lays out and 
prints the specified number of 
images with no gaps between 
images on the page.
Canon perforated paper printing

2. Select the paper size.
When you click [Next], a window for selecting the layout appears.

3. Select the layout.
When you click [Finish], the PhotoRecord window appears.

Select the layout 
method.

Use the preview to 
check the print layout.

The paper type and size 
options correspond to 
the selected print mode.
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Use these buttons to 
change how the images 
are aligned. Click the 
arrow ▼ to display a 
pop-up menu.

You can drag the 
images to move them 
to new positions. 

If you click [Save As] on 
the [File] menu, you can 
save the laid out page 
as an album.

Layout
Click this to switch 
between auto index and 
manual layout mode.

Print Modes
Click this to set the 
printing mode or paper 
size.

Page Art
Click this to change the 
page background or 
borders.

Undo / Redo
Click these buttons to undo or restore 
the previous action.

Fetch Photos
Click this to import still 
images.

Print
Click this to display the 
Print Dialog.

Page title
To change the page 
title, click ▼ on the left 
side of the window 
and on the menu that 
appears, click [Title] 
and [Edit].

Image caption
To change the image 
caption, right-click the 
image and, on the 
shortcut menu, click 
[Caption] and [Edit]. 
Then, type a 
description about the 
image.

Text box
To add text to the page, 
click ▼ on the left side 
of the window and on 
the menu that appears, 
click [Add Text] and 
type what you want. 
Also, if you right-click 
the text box, you can 
click [Change Text] on 
the shortcut menu and 
change its frame or 
other artwork.

Stop Fetch
Click this to stop 
importing still images.

Click this to display Help.

Switch between control 
panel sizes with this.

Image Size
Slide this tab to the left 
to shrink the image, 
right to expend it.

The PhotoRecord Window
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Printing Still Images (PhotoRecord)

❍ You can add images directly to a page. You simply need to drag the
image that you want from the Browser Display Area of
ZoomBrowser EX to a page in the PhotoRecord window.

❍ To Change the Page Artwork
Click t and select [Change Page Artwork] from the displayed menu.

❍ To change the Photo Frame
Click t and select [Change Photo Frames] from the displayed menu.

❍ Changing the size or rotation angle of an image
Place your mouse pointer over the image that you want to change,
then use the following operations to change its size or angle.

You cannot alter the size or rotation angle if you selected [Fixed
photo size] or [Canon perforated paper] as the print mode.

❍ Changing the number of images on a page
You can change the number of images on one page. On the [Edit]
menu, click [Preferences] and specify the number of images you
want to have on one page of the album.

Drag these to 
change the size 
of the image.

Drag this to 
rotate the 
image.

Use this button to display a 
menu that helps you 
manipulate the image.

Use this button to switch 
between the size and 
rotation options.

Set the number 
of images on 
one page here.
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Adjusting Image Quality and Printing (Exif 2.2 Compliant)
The PhotoRecord utility features functions that allow you to print images with
image quality adjustments and also supports the Exif 2.2 standard (or Exif
Print). This function automatically selects optimal image correction settings to
produce better prints.

Still images recorded with camcorders complying with the Exif 2.2
standard incorporate recording settings information, such as the
recording conditions and scene mode, along with the image data. The
Exif Print adjustment protocol uses this information to correct the
image quality more accurately to reflect the recording settings.

1. Right-click an image you wish to print and select [Clip/
Correct Photo].

2. Place a check mark beside [Exif Print] or [Photo Optimizer
Pro] and click [Close].
The selected image will be corrected.
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Selecting the Print Mode and Number of Copies (DPOF Print Settings)
You can select the image and the number of prints (  print setting) for
automatic printing on a DPOF*-compliant printer. You can set the DPOF print
settings also on the camcorder.
*Digital Print Order Format

When you are using a SD memory card, make sure the protect switch is
set to allow recording.

❍ You can include the date and file number in the print. Click [Edit] in
the [Edit Slide/DPOF] window and select [Titles].

❍ The Edit Slide/DPOF window allows print settings on up to 998 still
images. With some camcorders, DPOF print settings are limited to a
maximum of 200 still images. In that case, all DPOF print settings on
the 201st still image and onward will be erased.

1. Click [Set] in the Camera Window and select [Slide/DPOF] in
the displayed menu.
The Edit Slide/DPOF window appears.

2. Select the still image you wish to print, the print mode and
the number of copies.
• [Standard Print]: Prints selected images in the specified number of

copies. Use the arrows next to the boxes below the image to select the
number of copies.

• [Index Printing]: Prints selected images as thumbnails (index). Place a
check mark in the box under the image to include an image to the index.

• [Both (Standard/Index)]: Peforms both standard print and index printing.

3. Click [Save to Camera].
The DPOF print settings will be saved to the memory card.

Printing Still Images (PhotoRecord)
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Merging Panoramic Images (PhotoStitch)

You can merge a series of overlapping images into a single, seamless
panorama. PhotoStitch automatically arranges still images recorded with the
camcorder’s Stitch Assist mode in their correct order and orientation, making
it easy to merge them. Please refer to the Camcorder Instruction Manual to
learn how to record in Stitch Assist mode.
The following instruction explains how to merge still images recorded in Stitch
Assist mode with the camcorder.

Still images recorded in Stitch Assist mode with Wide-converter or Tele-
converter attached cannot be merged correctly.

1. Click the arrow in the Camera Window.

2. In the confirmation window, click [OK].
PhotoStitch starts.

3. Arrange the order of the images and click [2.Merge].
Operational instructions are displayed in the upper section of the window.
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❍ You can record the surroundings in 360 degrees, and stitch them
together later to form a 360-degrees cylinder. (In [1. Selection and
Arrangement], select [Arrange] and [360 degrees].) By saving this
stitched image in QuickTime VR format, you can then get a virtual
view of the surroundings. For this, you need to have QuickTime
installed on your computer.  If it is not already installed, install it from
the DIGITAL VIDEO SOLUTION DISK.  Place the disk in the CD-ROM
drive and click [QuickTime 5.0 Installation] in the installer panel.

❍ Please refer to the ZoomBrowser EX and PhotoStitch Help menu for
more details.

Merging Panoramic Images (PhotoStitch)

4. Click [Start].

5. Select [3. Save] and then click [Save].
• Select the destination folder, input the file name and click [Save].
• In the View the Saved Image? window, click [Yes]. The Viewer window

opens and displays the merged image.
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Adding Still Images from Your Computer to the Memory Card

You can add still images from the computer to a memory card. You can also
add sample images for card mix and card animation from the DIGITAL VIDEO
SOLUTION DISK.

Only still images in JPEG format can be added to the memory card.

Adding Still Images to the Memory Card

1. Click [Camera & Memory Card] in the Main Window.

2. Click [Upload Images].
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Adding Still Images from Your Computer to the Memory Card

4. In the Add Image window, select the image size and click
[Add].
• The selected images will be recorded to the memory card.
• When recording is complete, the images will appear in the Camera

Window.

3. Select the images you wish to add and click [Open Camera
Window].
You can select multiple images by continuously clicking on the images.
Click on the image again to deselect.
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Adding Sample Images to the Memory Card
You can add sample images for card mix and card animation to the memory
card. 4 images for CARD CHROMA, 2 images for CARD LUMINANCE, 2
images for CAMERA CHROMA and 4 images for CARD ANIMATION are
provided on the DIGITAL VIDEO SOLUTION DISK.

1. Insert the DIGITAL VIDEO SOLUTION DISK to the computer’s
CD-ROM drive.

2. Click [Camera & Memory Card].

3. Click [Upload Images].

4. In the Folders Area of the Main Window, select the CD-ROM
icon followed by [DVC CARD IMAGE].
Sample images or folders for CARD CHROMA, CARD LUMINANCE,
CAMERA CHROMA or CARD ANIMATION appear in the Browser Area.
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5. Select the sample images you wish to add and click [Open
Camera Window].
You can select multiple images by continuously clicking on the images.
Click on the image again to deselect.

6. In the Add Image window, click [Add].
• The selected images will be recorded to the memory card.
• When recording is complete, the sample images will appear in the

Camera Window.

Adding Still Images from Your Computer to the Memory Card
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Adding a Start-up Image to the Memory Card

Adding a Start-up Image to the Memory Card

❍ Image files that do not appear in the [Computer] list of the DVC My
Camera window cannot be saved to the camcorder.

❍ Do not detach the USB cable, turn the camcorder power off, or
disconnect the camcorder from the computer while the start-up
image is being saved to the memory card.

1.  Click [Camera & Memory Card] in the Main Window.

2. Click [My Camera Settings].
The Select My Camera window appears.

3. Select [My Camera for Digital Video Cameras] and click [OK].
The DVC My Camera window appears, displaying the start-up images
saved on the computer.
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Adding a Start-up Image to the Memory Card

4. Click [View Camera].

5. Confirm that your camcorder model name is selected and
click [OK].

6. Select the start-up image you wish to save to the memory
card from the [Computer] list and click the  button.
• The selected start-up image is displayed in the preview area to the right.
• The file name of the saved start-up image appears in the [Camera] list.
• Start-up images will be saved to the [Dcim] folder in the memory card.

7. Click [Close].
Follow the instructions in Customizing the Camcorder in the Camcorder
Instruction Manual and change the My Camera setting.
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Adding New Start-up Images to the DVC My Camera Window
Create a start-up image using an image editing application program. Create
the file in the JPEG format at a size of (w) 320 x (h) 240 pixels.

Once you have created the start-up image and saved it to the computer, use
the following procedures to add it to the DVC My Camera window.

1. Open the DVC My Camera window, and click [Add].

2. Select the file you created in the [Open file] dialog and click
[Open].
• The selected file appears in the [Computer] list.
• You can save the newly created file to the memory card using the

procedures described in Adding a Start-up Image to the Memory Card
(  47).

• To delete a start-up image, select it and click the [Delete] button.

The newly added data will 
appear here
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Setting ZoomBrowser EX to Start Automatically

You can set ZoomBrowser EX to start automatically when you connect the
camcorder to the computer.

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  16).
When a window appears allowing you to select an application program to
start, click [Cancel].

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see Troubleshooting
the TWAIN Driver/WIA Driver Uninstall (  55).

7. Make sure that your camcorder model is selected and click
[Properties].

8. Click the [Events] tab.

9. Remove the check mark from all programs except
ZoomBrowser EX and click [OK].
The next time the camcorder is connected, ZoomBrowser EX starts and
the Camera Window opens automatically.

Windows 98/Windows 2000
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1. Insert a memory card containing still images/movies into the

camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  16).
When the Scanners and Cameras Wizard opens, click [Cancel].

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see Troubleshooting
the TWAIN Driver/WIA Driver Uninstall (  55).

7. Double-click the icon of your camcorder model.

8. Click the [Events] tab.

9. In the [Actions] section, select [Start this program], set it to
[Canon ZoomBrowser EX] and click [OK].
The next time the camcorder is connected, a window appears allowing
you to select an application program to start.

Windows Me
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10.Select [Canon ZoomBrowser EX], place a checkmark beside
“Always use this program for this action” and click [OK].
• ZoomBrowser EX starts and the Camera Window opens automatically.
• The next time the camcorder is connected, ZoomBrowser EX starts and

the Camera Window opens automatically.

Windows XP

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  16).
A window appears allowing you to select an application program to start.

5. Select [Canon ZoomBrowser EX], place a check mark next to
“Always use this program for this action” and click [OK].
The next time the camcorder is connected, ZoomBrowser EX starts and
the Camera Window opens automatically.

Setting ZoomBrowser EX to Start Automatically
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❍ If you have uninstalled ZoomBrowser EX because of a corrupt
database file or other problem, please also delete the Database
folder, which can be found within the [C:\Program Files\Canon\
ZoomBrowser EX] folder.

❍ PhotoRecord and PhotoStitch can be removed with the same
procedure.

Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or
when reinstallation is required to fix corrupted files.

Users of Windows 2000 and Windows XP must first log in as an
Administrator to uninstall the driver and other programs.

Uninstalling ZoomBrowser EX

1. Click the Windows [Start] menu and select [Programs],
[Canon Utilities], [ZoomBrowser EX] and [ZoomBrowser EX
Uninstall].
The uninstall utility starts and removes ZoomBrowser EX.
Uninstall the Camera Window with the same procedure.

Uninstalling the TWAIN Driver/WIA Driver

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.
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Uninstalling the Software

4. Connect the camcorder to the computer using the supplied
USB cable (  16).
A window for selecting an application program or the Scanners and
Cameras Wizard appears, or ZoomBrowser EX starts.

5. If the window for selecting an application program or the
Scanners and Cameras Wizard appeared, click [Cancel]. If
ZoomBrowser EX started, close it.

6. Click the Windows [Start] menu and select [Settings] and
[Control Panel].
Windows XP : Click the Windows [Start] menu and select
[Control Panel] and [Printers and Other Hardware].

7. Double-click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see Troubleshooting
the TWAIN Driver/WIA Driver Uninstall (  55).

8. Windows 98/Windows 2000:
1. Delete the camcorder model name from the [Scanners and Cameras

Properties] list.
2. Click [OK] to close the window.
3. Click the Windows [Start] menu and select [Programs], [Canon

Utilities], [*** TWAIN Driver] and [TWAIN Driver Uninstall].
 The model name of your camcorder appears in place of the asterisks
(***).

Windows Me/Windows XP:
1. Delete the camcorder icon from the [Scanners and Cameras] folder.
2. Click [OK] to close the window.
3. Click the Windows [Start] menu and select [Programs], [Canon

Utilities], [*** WIA Driver] and [WIA Driver Uninstall].
 The model name of your camcorder appears in place of the asterisks
(***).

9. When the Confirm Uninstall window appears, click [OK].
The uninstall process starts.

10.When the Maintenance Complete window appears, click
[Finish].
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Troubleshooting the TWAIN Driver/WIA Driver Uninstall
If you had problems uninstalling the driver, use the following procedures to
remove it.

Use the procedures below for the following circumstances too.
❍ If you do not find [Scanners and Cameras] in the [Control Panel] or

[Printers and Other Hardware].
❍ If your camcorder model name does not appear in the [Scanners and

Cameras Properties] or [Scanners and Cameras].
❍ If you connected the camcorder to the computer via the USB cable

before installing the software/driver on the DIGITAL VIDEO
SOLUTION DISK.

Leave the camcorder connected to the computer.

1. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

2. Double-click the [System] icon.
The [System Properties] dialog appears.

3. Click the [Device Manager] tab.

4. If your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.
1. Select the name of the camcorder model and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

5. Double-click the [My Computer] icon on the desktop followed
by the [C:] drive and the [Windows] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Windows] Folder
1. Windows 98: Click the [View] menu and select [Folder Options].

Windows Me: Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. Windows 98: Set the [Hidden files] section to [Show all files].

Windows Me: Set the [Hidden files and folders] section to [Show
hidden files and folders].

4. Click [OK].
This makes the [Inf] folder and files in the [Inf] folder visible.

Windows 98/Windows Me
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Uninstalling the Software

6. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

7. In the [Inf] folder, double-click [Other] folder to open it.

8. Find and delete the [Canon.IncCAP_***] folder.
• The model name of your camcorder appears in place of the asterisks

(***).
• A window for selecting an application program or the Scanners and

Cameras Wizard appears, or ZoomBrowser EX starts.
• If the above file is not contained in the [Other] folder, you do not need

to delete anything.

The [Inf] folder contains numerous files that are critical to the
computer’s operation. Be extremely careful not to delete the wrong
files. If you delete the wrong file, you may be unable to restart
Windows.

Leave the camcorder connected to the computer.

1. Windows 2000: Click the Windows [Start] menu and select
[Settings] and [Control Panel].
Windows XP: Click the Windows [Start] menu and select
[Control Panel] and [Performance and Maintenance].

2. Double-click the [System] icon.

3. Click the [Hardware] tab.

4. Click the [Device Manager] button.

5. If your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.
1. Select the name of the camcorder model, right-click the mouse button

and select [Delete].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

Remove all copies of your camcorder model name that appear in the
[Other Devices] or [Imaging Devices] categories, or that appear more
than once in one category.

Windows 2000/Windows XP
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6. Windows 2000 : Double-click the [My Computer] icon on the

desktop, followed by the [C:] drive, and the [Winnt] and [Inf]
folders.
Windows XP : From the [Start] menu, click [My Computer],
[C:], [Windows] and [Inf] folders in succession.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder
Use the following procedures to show all files and folders.
1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Advanced setting] section, set the [Hidden files and folders]

category to the [Show hidden files and folders] option.
 If [Hide extensions for known file types] is selected, remove its check
mark.

4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.

7. Look for the file starting with [OEM*].
• A number such as ”0” or “1” will appear in place of the asterisk (*)

above. You will also find another file called [Oem*.pnf], which will have
the same number as the [Oem*] file. The two constitute one set.

• There may be many file sets starting with “Oem”.
• If you double-click the [Oem*] file, the Windows Notepad program will

start and show the file contents. Click each [Oem*] file until you find
one that contains “*** Canon Camera Driver Setup File***” in its first
line. When you find the correct file, note down its name and close the
Notepad window.

8. Delete the [Oem*] file set.
Delete all [Oem*] and [Oem*.pnf] files, taking great care to delete the
correct files.

The [Inf] folder contains numerous files that are critical to the
computer’s operation. Be extremely careful not to delete the wrong
files. If you delete the wrong file, you may be unable to restart
Windows.
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Troubleshooting

? Cannot download images, camcorder is not recognized when the
camcorder is connected via the USB interface.

➜ Computer does not support the USB interface.
The USB interface is not supported for computers not in compliance with
the following requirements. Acquire the necessary system to use the USB
interface.
Requirements: Built-in USB interface on a system preinstalled with one of
Windows 98/Windows Me/Windows 2000/Windows XP.

➜ There is no memory card in the camcorder.
Insert a memory card into the camcorder.

➜ The camcorder is not set to the correct mode.
Slide the POWER switch to PLAY (VCR) and the TAPE/CARD switch to
CARD.

➜ Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer (  16) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

➜ If you are experiencing operational problems, detach the USB cable
from the camcorder and computer and terminate the connection.
Restart the computer and then reconnect the camcorder.

➜ TWAIN Driver or WIA Driver is not installed properly.
First uninstall the TWAIN Driver/WIA Driver, then reinstall the driver from
the DIGITAL VIDEO SOLUTION DISK (remove the check marks from the
other programs when prompted to select the programs to be installed). For
uninstalling refer to Installing the TWAIN Driver/WIA Driver (  14). For
installing refer to Uninstalling the TWAIN Driver/WIA Driver (  53).

? Cannot install the TWAIN Driver, WIA Driver correctly.

➜ Does the system have a built-in USB port and did it come with
Windows 98 (First or Second Edition), Windows Me, Windows 2000,
or Windows XP preinstalled?

➜ Is the camcorder correctly connected to the computer?

➜ Are you using the AC power adapter to power the camcorder?

If the Problem Is Not Mentioned Above
If the USB TWAIN Driver/USB WIA Driver has not correctly installed,
Windows may not recognize the driver.  Uninstall the driver according to
the instructions (  53) and reinstall the driver.
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? Image files or folders do not appear in ZoomBrowser EX.

➜ Images or folders shown in ZoomBrowser EX and the actual file
contents may be different when an image file has been moved or
copied using Windows functions or edited with a separate
program. In such case, click the [View] menu and select [Refresh
Current Folder].

? Titles and comments added using a prior version of ZoomBrowser
EX do not appear in ZoomBrowser EX 4.0.

➜ Titles or comments added using a prior version of ZoomBrowser EX
will not be displayed. Use the following procedure to display them.
1. In Windows Explorer, open the [Program] folder under the folder in

which you installed ZoomBrowser EX 4.0 (C:\Program
Files:\Canon:\ZoomBrowser EX:\Program).

2. Double-click [dbconverter.exe].
3. Select the database you were using until now (C:\Program

Files:\Canon:\ZoomBrowser EX:\Program) and click the [Start] button.
Please note that with ZoomBrowser EX 4.0, both titles and comments
appear in the comment list.

? Cannot find the image folders saved on the prior version of
ZoomBrowser EX 4.0.

➜ Image folders saved under the [Program Files] folder (such as
[Image Library One]) cannot be displayed in the Main Window's
Folder Area of ZoomBrowser EX version 4.0. Use the following
procedure to display them.
1. In Windows Explorer, open the [Program] folder under the folder in

which you installed ZoomBrowser EX 4.0 (C:\Program
Files:\Canon:\ZoomBrowser EX:\Program:\Image Library One).

2. Select the image folder you wish to display and copy the folder to a
different destination.
The images in the folder will be displayed.
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Macintosh  System Requirements

OS: Mac OS 9.0-9.2, Mac OS X (10.1/10.2)
Computer Model: Computers that come with above OS preinstalled and

have built-in USB ports.
CPU: PowerPC
RAM: Mac OS 9.0-9.2: 20 MB or more of application memory

Mac OS X (Version 10.1/10.2): 128 MB or more
Interface: USB
Free Hard Disk Space: Canon Utilities

– ImageBrowser 50 MB or more
– PhotoStitch 30 MB or more

Display: 800 × 600 pixels/32,000 colors or better, 1,024 × 768
pixels/32,000 colors or better is recommended

❍ Proper operation is not guaranteed on a user-built PC.
❍ Proper operation is not guaranteed on any particular system, even if

it meets the requirements outlined above.
❍ A CD-ROM drive is required to install the software.
❍ Connect the USB cable directly to one of the computer’s main USB

ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

❍ The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

❍ Do not connect two or more camcorders to the same computer via
the USB interface. The connections may not operate correctly.

❍ Not all operations performed with a connection to a USB 2.0
compatible board can be guaranteed.
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What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained
on the DIGITAL VIDEO SOLUTION DISK.

■ ImageBrowser (  65)
• Downloading still images/movies recorded onto a memory card to your

computer.
• Categorizing and organizing large volumes of still images/movies.
• Searching and organizing images chronologically.
• Creating mail attachments from still images.
• Laying out and printing still images.
• Printing indexes.

■ PhotoStitch (  89)
Merging panoramic images.

Download from Www.Somanuals.com. All Manuals Search And Download.



62

Before you attach the camcorder to the computer with the USB cable
for the first time, you must install the driver from the DIGITAL VIDEO
SOLUTION DISK.

1. Close any programs that are running.

2. Set the DIGITAL VIDEO SOLUTION DISK in the computer’s CD-
ROM drive.

3. Mac OS 9.0-9.2: Double click the CD-ROM icon, followed by
the [Mac OS 9] and [Canon Digital Video Installer] icons.
Mac OS X (10.1/10.2): Double click the CD-ROM icon,
followed by the [Mac OS X] and [Canon Digital Video
Installer] icons.
The installer panel appears.

4. Select your language.

5. Click [Digital Video Software Installation].

6. Select the programs you wish to install and click [Install].
Confirm that there is a check mark beside the name of the program you
wish to install.

Installer Panel

Installing the Software
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7. Read the license agreement and click [Agree].

8. Select the installation destination and click [Choose].
Installation starts.

9. When the message “Installation has finished.” appears, click
[OK].

10.After the installation is complete, restart the computer as
prompted.
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Connecting the Camcorder to a Computer

❍ Make sure the camcorder is being powered using the power adapter
before connecting it to a computer.

❍ Be sure to install the DIGITAL VIDEO SOLUTION DISK before you
connect the camcorder to the computer.

❍ Connect the USB cable directly to one of the computer’s main USB
ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

❍ The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

❍ Do not connect two or more camcorders to the same computer via
the USB interface. The connections may not operate correctly.

❍ Never allow the computer to go into standby (sleep) mode
while a camcorder is connected via the USB interface. If it does
happen, never disconnect the USB cable. Try to awaken the
computer with the camcorder in the connected state. Some
computers will not awaken properly if you disconnect the
camcorder while they are in standby mode. Please refer to your
computer manual for instructions regarding its standby mode.

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the power adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
• You do not need to turn off the computer for this procedure.
• Refer to your computer manual for the location of the computer’s USB ports.
• See your camcorder instruction manual for connecting instructions.

USB Cable

Camcorder End Computer End

USB Terminal
on the Camcorder

USB Port on 
the Computer
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Downloading Still Images/Movies (ImageBrowser)

Below explains the procedure for connecting a camcorder to a computer using
the USB cable.
For connecting a PC card reader/writer, see Using a PC Card Reader/Writer (
71).

❍ Observe following precautions when the camcorder’s card access
indicator is flashing (the camcorder is reading or writing from or to
the memory card). Failure to do so may cause memory card data to
become corrupted.
– Do not remove the memory card or detach the USB cable.
– Do not turn off the camcorder or the computer.
– Do not change the position of the POWER switch or the TAPE/

CARD switch.
❍ Format the memory card with the camcorder or from the Camera

Window (  73).
❍ Still images/movies recorded onto the memory card or downloaded

to the hard disk are important original data files. Create a copy of
the file first before working on it on your computer.

Starting ImageBrowser

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

Mac OS 9.0-9.2
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Downloading Still Images/Movies (ImageBrowser)

4. Connect the camcorder to the computer using the supplied
USB cable (  64).
• ImageBrowser starts and the ImageBrowser Automation Wizard dialog

appears. In the ImageBrowser Automation Wizard dialog, you can
select the action that is carried out after ImageBrowser starts.

• A dialog with the previously selected automated settings will appear the
next time you start ImageBrowser.
1. To use these settings unchanged, click the [Start] button.
2. To do nothing, click [Cancel].
3. To change the settings, click [Settings Change], select the action and

click [OK].

5. Select [Display Images] and click [OK].
The Communications Settings window appears. This window only
appears the first time the camcorder is connected.

6. Confirm that [USB port] and your camcorder model name are
selected and click [Set].
The Camera Window opens, displaying the camcorder images as
thumbnails (small images).

Your camcorder model name 
appears here.
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How to Set ImageBrowser to Not Start Automatically

1. Click the Apple menu  and select [Control Panels] and
[Canon ImageBrowser Auto Launch].
The Settings for USB Connection dialog will display.

2. Click [The application program below will start] to clear the
check mark.

3. Click the close box  at the upper left to close the dialog.
ImageBrowser will cease to start automatically thereafter.

Click here to close the dialog.

Mac OS X (10.1/10.2)

Do not connect the camcorder while the Classic environment is started.
Likewise, do not start the Classic environment while the camcorder is
connected.

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (  64).
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7. Confirm that [USB port] and your camcorder model name are
selected and click [Set].
The Camera Window opens, displaying the camcorder images as
thumbnails (small images).

5. Double-click the [Canon ImageBrowser] icon on the desktop.
If the Canon ImageBrowser icon does not appear on the desktop, double-
click the [Canon Utilities] folder on the drive on which the program was
installed, followed by the [ImageBrowser] folder and [ImageBrowser] icon.

6. Click [Canon Camera] in the Explorer View section.
The Communications Settings window appears. This window only
appears the first time the camcorder is connected.
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Downloading Still Images/Movies to the Computer

When using the ImageBrowser’s Camera Window to download images
from the camcorder’s memory card, make sure to select [Macintosh
HD]. The image will not be saved to the computer when [DCIM] is
selected. Follow the instructions below.

1. Mac OS 9.0-9.2: Select [Macintosh HD] in the explorer view
section.

Mac OS X (10.1/10.2): Select the [  (user name)] subfolder
of the [Users] folder in [Macintosh HD].

2. Create a new folder for saving images from the memory card
in the camcorder.
Click the [File] menu and select [New Folder]. A folder with the name
“Untitled” will be created. Click it to change the folder name as you wish.
In this example, we will input “ZOO.”

Explorer View Section

3. In the Explorer View Section, click the newly created folder.
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4. Select still images/movies in the Camera window and click
[DOWNLOAD].
• A blue frame appears around the selected still image/movie.
• Downloaded still images/movies are saved to the computer and appear

in the Browser area.

To disconnect the camcorder, click the close box (Mac OS 9.0-9.2) or the red
close box (Mac OS X (10.1/10.2)) at the upper left of the Camera Window.
The Camera Window will close.

Thumbnail

Explorer View Section

Browser area
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Using a PC Card Reader/Writer
This section explains only the instructions which differ when connecting a PC
Card Reader/Writer instead of the camcorder.
For instruction on how to connect the PC Card Reader/Writer, please refer to
the PC Card Reader Manual.

1. Insert a memory card into the reader.
Mac OS X (10.1/10.2): If a dialog appears, click the red close box.

2. Double-click the [Canon ImageBrowser] icon on the desktop.
• ImageBrowser starts.
• If the icon does not appear on the desktop, double-click the folder in

which you installed the program, followed by the [Canon Utilities] and
[ImageBrowser] folders and the [ImageBrowser] file.

3. Double-click the [CANON_DV] and [DCIM] folders in the
Explorer View Section.
The Camera Window opens, displaying the memory card images as
thumbnails (small images).

❍ Double-clicking a still image/movie on the camera window imports it
to the computer.

❍ You can also download still images/movies to the computer by
dragging them from the Camera window and dropping them on the
Browser area or the Explorer View Section.

❍ You can select multiple still images/movies by holding down [Shift] or
[Option] + [Shift] while clicking.

Explorer View Section
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Thumbnail
The still image/movie is 
displayed reduced in size.

Movie icon

Using Other ImageBrowser Functions

Camera Window
The Camera Window opens when a connection to a camcorder is initiated.
Still images/movies will be displayed as thumbnail (small) images (Movies are
displayed with the first scene as a still image, indicated with a movie icon).
Buttons are activated when a still image/movie is selected.

[SETUP OPTIONS]: Adjusts the connection settings and camcorder
settings. Menu options: Camera Settings and
Communications Settings.

[CONNECT CAMERA]: Reconnects the camcorder to the computer.
[SELECT]: Selects still images/movies. Menu options: Select All

and Deselect All.
[DELETE]: Deletes selected still images/movies.
[DOWNLOAD]: Downloads selected image to the computer.
[PRINT]: Prints selected still images. Menu options: Layout

printing and Index printing.
[ROTATE]: Rotates still images. Menu options: 90 degrees

right, 90 degrees left and 180 degrees.
[UPLOAD]: Adds selected still images to the memory card.
[IMAGE INFO]: Displays image information (such as shooting date/

time and image size).
[SLIDE/DPOF]: The [SLIDE] function cannot be used. [DPOF] allows

you to select the print order settings.

Mac OS X (10.1/10.2): Be careful when erasing images in the
ImageBrowser Camera Window. Even images you protected with the
camcorder will be erased permanently.
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Camera Setting Window
You can adjust the date, time and owner settings in the Camera Settings
window using the computer when the camcorder is connected. You can also
check the remaining memory card capacity.

1. In the Camera Window, click the [Setup Options] button and select
[Camera Settings] from the displayed menu.

2. Check or change the settings.
Click [OK] to close the window.

Input a camcorder owner name here 
(up to 31 characters).

Set the date and time here.

Click this button to synchronize the camcorder 
to the computer’s date and time settings.

Check the battery status here.

Click this to format the memory card 
in the camcorder. 

Check the remaining memory card 
capacity here.
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Image Name
This is where 
the file name 
of each 
individual 
still 
image/movie 
is displayed.

Explorer View Section
Displays the disks and folders 
that you can use on your 
computer.
If you click the disclosure 
triangle on the left edge of the 
display, you can switch between 
collapsing and expanding the 
contents of that folder.

You can drag this line to 
change the position of the 
boundary between the 
Explorer View Section and 
the Browser Area.

You can drag this part 
of the frame to 
change the size of the 
Browser Window.

Control Panel
This area contains 
buttons that allow 
you to perform a 
variety of functions.

Browser Area
This is the area where thumbnails of 
still images/movies in the selected 
folder are displayed.

Movies are 
displayed 
with an 
movie icon.

Browser Window
This section describes the various parts of the Browser Window display.

[CANON CAMERA]: Displays the Camera Window.
[SELECT ALL]: Selects all still images/movies in a folder.
[SEND TO TRASH]: Deletes selected still images/movies.
[REDUCE]: Reduces the size of the thumbnails in the Browser

Area.
[ENLARGE]: Enlarges the size of the thumbnails in the Browser

Area.
[DISPLAY IMAGE]: Displays a still image in the Image Viewer window, or

opens a window for playing back a movie.
[PRINT]: Prints selected still images. Menu options: Layout

printing and Index printing.

Using Other ImageBrowser Functions
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Image Viewer Window
The Image Viewer window appears when you double-click a still image, or
when you select a still image and click [DISPLAY IMAGE].

CROP
You can extract a part of the image.
1. Click on the image and drag to form a rectangular 

frame. 
You can move or change the size of the frame.

2. Click this button to extract the area within the 
frame. 
The extracted part of the image appears.

ADJUST COLOR
Click here to display the 
Adjust Color window to 
adjust hue, saturation and 
lightness of the image by 
dragging the respective slide.

Enlarge or reduce the 
image

Current zoom ratio
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Using Other ImageBrowser Functions

Displaying the Image Information
You can check the image information such as shooting date/time or file size.

1. Select the image of which you wish to display the
information.

2. From the [File] menu, select [Get Info].
• The File Information window appears.
• If you wish to add a comment, input it in the [Comment] area.
• Click [OK] to close the window.

❍ It depends on your camcorder model which image information will
be displayed.

❍ When you modify and save an image using another program,
shooting information or comments may be lost.
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[View] Menu
You can select the display settings of the Browser Area from the [View] menu.

If you select [View Mode] followed by [Preview] from the [View] menu, you
can display a preview of a still image in the Browser Area. To stop displaying
the preview image, select [View Mode] followed by [List] in the [View] menu.

Allows you to 
enlarge and 
reduce the 
size of the 
thumbnails.

Allows you to 
enlarge or 
reduce the 
size of the 
thumbnails.

Allows you to select 
the information 
displayed under the 
thumbnails.
Allows you to select 
the operating panel 
displayed below the 
Browser Area.
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Displaying Images in TimeTunnel

This program displays images in the order of the creation date.

1. In the [View] menu, select [View Mode] followed by
[TimeTunnel].
The image information will be displayed when you point at an image.

Double-click a thumbnail 
to display it in another window.

The date/time at which the images were shot 
appears on the red line. You can change this 
date/time by double-clicking it on the display. 
A window similar to the one below appears. 
Specify the new date/time.

Click to display the control panel.
[Display Tool Panel]: 

Select to display or hide the tool 
panel.

[Auto Cruise]: 
Enables or disables [Auto Cruise]. 
When [Auto Cruise] is active, the time 
movement continues even after you 
have moved and released the bar.

[Switch to Browser View]: 
Exit TimeTunnel, and returns to the 
previous screen.

Tool Panel

Allows you to 
specify the date 
for the images 
displayed.

Makes the 
TimeTunnel look 
curved.

Makes the 
TimeTunnel rings 
octagonal.

Changes the number 
of TimeTunnel rings.

Move the slider up 
or down to move 
backward or 
forward in time.
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Playing Back Movies From a Memory Card

In the Camera Window and Browser Area, movies are displayed with the first
scene as a still image with a movie icon (  ). When you double-click the
thumbnail in the Browser Area, QuickTime Player starts and plays back the
movie.

1. In the Browser Area, double-click a thumbnail with a 
(movie) icon.
QuickTime Player starts.

2. Click the e (play) button in QuickTime Player.
The movie will be played back.
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Running a Slide Show

1. From the [View] menu, select [Slide Show Options].

2. Select the slide show settings and click [OK].
• [Auto Play]: Moves to the next still image automatically. Select the

interval by sliding the control under [Play Interval] (from 1 to 30
seconds).

• [Control with Mouse or Keypad]: Advances the slide show manually
with the mouse or keyboard.

• [Repeat Continuously]: Runs the slide show in a loop.
• [Hide buttons]: Hides the buttons during the slide show.
• [Transition Effect]: Select the transition effect to be used when moving

from one slide to another. When you select an effect, you can check the
effect in the preview window.

3. Select the images and select [Slide Show] from the [View]
menu.
Click  on the lower right of the screen to end the slide show.
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Attaching Still Images to E-mail Messages

You can attach selected still images to an E-mail message.

1. Select the images you wish to send in the Browser Area.

2. From the [Internet] menu, select [Create Image for Email].

3. Specify the image size and click [Next].

4. Specify the reduction ratio and image quality and click
[Next].
• [Resize (%)]: Select the reduction ratio relative to the original size of the

image.
• [Quality]: Select the image quality. The lower the quality, the rougher

the image becomes, but the size of the file also becomes smaller.
• [Compress]: Use it to check the file size when you actually compress the

image. The file size appears next to “Total Size After Compression”.

Select this if you do not wish to 
reduce the size of the still image.
Normally, select this option.
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5. Select whether you wish to start your e-mail program and
click [Finish].
• If you have selected [Start email application after closing], your e-mail

program starts automatically. Open a new e-mail message and attach
the image. With Outlook Express or other types of e-mail programs, you
can attach images to e-mail messages simply by dragging them from
the Browser Area to the new message window.

• Click [Preview] to check the changed image.
• The image will be saved to the [Email Images] folder in the explorer

view section.

❍ You can set the e-mail program to start automatically in step 5. Note
that some e-mail programs may not start automatically.
Mac OS 9.0 ~ 9.2: From the Apple menu, select [Control Panel],
followed by [Internet] and click the [Email] tab. Change the setting in
the displayed window.
Mac OS X (10.1/10.2): From the Apple menu, select [System
Preferences], followed by [Internet] and click the [Email] tab. Change
the setting in the displayed window.

❍ The images in the [Email Images] folder are saved in the following
location:
Mac OS 9.0 ~ 9.2: Open the disk you installed ImageBrowser or the
[Documents] folder, followed by [ImageBrowserUserData] and [Mail].
Mac OS X (10.1/10.2): Open the [Users] folder, followed by [User
login name], [Library], [Preferences], [ImageBrowserUserData], and
[Mail].

Explorer View Section

Attaching Still Images to E-mail Messages
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Do not remove the memory card, detach the USB cable or turn off the
camcorder while data is being transferred to the printer (when the
camcorder’s card access indicator is flashing). Doing so may cause
memory card data to become corrupted.

1. Select the still image(s) you wish to print in the Browser
Window.
Movies cannot be printed.

2. Click [PRINT] and select [Layout printing] from the displayed
menu.
• The Layout Options window and Print window appears.
• If the Layout Options window does not appear, display it by clicking

[LAYOUT OPTIONS] in the Print window.

Printing Still Images (ImageBrowser)

You can select the layout when printing still images.

Print Window
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Printing Still Images (ImageBrowser)

3. In the Layout Options window, select a layout and click
[Next].
The Custom Layout printing option allows you to freely change the size
and position of the still images for printing. The other options allow you
to print an index or print onto Canon perforated paper. Canon perforated
paper cannot be selected with Mac OS X (10.1/10.2).

Layout Options Window

4. Select a paper size and click [OK].
• The Print window opens, allowing you to change the layout and

printing settings.
• The settings available will vary according to the type of layout selected

in Step 3.

5. Click [PRINT] in the Print window.
The Print dialog appears.

6. Click [Print].
Printing starts.
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Change the Image 
Size
Drag the border to 
resize the still image. 

Change the default 
number of still 
images printed per 
page. 
Click this to rotate 
the selected still 

Click this to reset 
the layout.

Edit the Page Title
Open the [Edit] 
menu and select 
[Edit Header].

Change the Layout
Drag the still 
image to change 
the layout.

Click this to select 
a layout type.

Click this to display 
the Print dialog.

Add Text
Open the [Edit] 
menu and select 
[Add Text].

Add Captions to Still 
Images
Click the still image 
and then the [Edit] 
menu and select 
[Edit Caption].

The Print Window
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Printing Still Images (ImageBrowser)

Adjusting Image Quality and Printing (Exif 2.2 Compliant)
ImageBrowser allows you to print images with image quality adjustments.
ImageBrowser also supports the Exif 2.2 standard (or Exif Print).

❍ Still images shot with camcorders complying with the Exif 2.2
standard incorporate shooting settings information, such as the
shooting conditions and scene mode, along with the image data.
The Exif Print adjustment protocol uses this information to correct
the image quality more accurately to reflect the shooting settings.

❍ When printing from ImageBrowser, the image quality adjustment
settings are active for all images.

1. Click the [Edit] menu in ImageBrowser and select
[Preferences].

2. In the Preferences window, select [Print], set the image
quality settings and click [OK].
See Printing Still Images for the next steps (  83).

Select this option to automatically 
correct only images shot with Exif 2.2 
compliant camcorders.

Select this option to automatically 
correct images shot with Exif 2.2 
compliant camcorders and 
other images.

A check mark must be placed here to
automatically correct the image 
quality.

Mac OS 9.0-9.2
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1. Click the [ImageBrowser] menu in ImageBrowser and select
[Preferences].

2. In the Preferences window, select [Print], set the image
quality settings and click [OK].
See Printing Still Images for the next steps (  83).

Select this option to automatically 
correct only images shot with Exif 
2.2 compliant camcorders.

Select this option to automatically 
correct images shot with Exif 2.2 
compliant camcorders and other 
images.

A check mark must be placed here to 
automatically correct the image 
quality.

Mac OS X (10.1/10.2)
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Selecting the Print Mode and Number of Copies (DPOF Print Settings)
You can select the image and the number of print (  print settings) for
automatic printing on a DPOF*-compliant printer. You can set the DPOF print
settings also on the camcorder.
*Digital Print Order Format

When you are using a SD memory card, make sure the protect switch is
set to allow recording.

❍ You can include the date and file number in the print. Click [Edit] in
the [Edit Slide/DPOF] window and select [Titles].

❍ The Edit Slide/DPOF window allows print settings on up to 998 still
images. With some camcorders, DPOF print settings are limited to a
maximum of 200 still images. In that case, all DPOF print settings on
the 201st still image and onward will be erased.

1. Click  (SLIDE/DPOF) in the Camera Window.
The Edit Slide/DPOF window appears.

2. Select the still image you wish to print, the print mode and
the number of copies.
• [Standard Print]: Prints selected images in the specified number of

copies. Use the arrows next to the boxes below the image to select the
number of copies.

• [Index Printing]: Prints selected images as thumbnails (index). Place a
check mark in the box under the image to include an image to the index.

• [Both (Standard/Index)]: Performs both standard print and index printing.

Printing Still Images (ImageBrowser)

3. Click [Save to Camera].
The DPOF print settings will be saved to the memory card.
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Merging Panoramic Images (PhotoStitch)

You can merge a series of overlapping images into a single, seamless
panorama. PhotoStitch automatically arranges still images recorded with the
camcorder’s Stitch Assist mode in their correct order and orientation, making
it easy to merge them. Please refer to the Camcorder Instruction Manual to
learn how to record in Stitch Assist mode.
The following instruction explains how to merge still images recorded in Stitch
Assist mode with the camcorder.

Still images recorded in Stitch Assist mode with Wide-converter or Tele-
converter attached cannot be merged correctly.

1. Click the green stitch mark in the Camera Window.

2. In the confirmation window, click [Yes].
PhotoStitch starts.

3. Arrange the order of the images and click [2.Merge].
Operational instructions are displayed in the upper section of the window.
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5. Select [3. Save] and then click [Save].
• Select the destination folder, input the file name and click [Save].
• In the View the Saved Image? window, click [Yes]. The Viewer window

opens and displays the merged image.

❍ You can record the surroundings in 360 degrees, and stitch them
together later to form a 360-degrees cylinder. (In [1. Selection and
Arrangement], select [Arrange] and [360 degrees].) By saving this
stitched image in QuickTime VR format, you can then get a virtual
view of the surroundings.

❍ For more details, please refer to the ImageBrowser and PhotoStitch
Help menu.

Merging Panoramic Images (PhotoStitch)

4. Click [Start].
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Adding Still Images from Your Computer to the Memory Card

You can add still images from the computer to a memory card. You can also
add sample images for card mix and card animation from the DIGITAL VIDEO
SOLUTION DISK.

❍ Still images in JPEG, TIFF, PICT, and Windows bitmap format can be
added to a memory card. However, the still images will be saved in
JPEG format on the memory card.

❍ You can also add still images to a memory card by using drag and
drop to move it from the browser area to the Camera window.

Adding Still Images to the Memory Card

1. In the camera window, click [UPLOAD].

2. Select the still image you wish to add and click [Open].
You can check the selected still image by clicking [Show Preview] in the
[Select images to add] window.
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Adding Still Images from Your Computer to the Memory Card

3. Select the image size.
• Confirm that your camcorder model name is displayed under [Camera

model].
• [Image Size]: Select [large] or [Small].
• [Adjust Height] and [Adjust Width] specify the standard for image

enlargement and reduction.
• Still image enlargement and reduction are not performed when both

[Adjust Height] and [Adjust Width] are deselected.
• When [Adjust Height] and [Adjust Width] are both selected, the aspect

ratio of the still image (the ratio between the height and width of  the
image) may change when the still image is resized.

• When you have selected multiple images in step 2, [Save subsequent
images with the same settings] will be activated. Click this button to
apply the current settings to subsequent images.

4.  Click [Save to Camera].
• The selected images will be recorded to the memory card.
• When recording is complete, the images will appear in the Camera

Window.
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Adding Sample Images to the Memory Card
You can add sample images for card mix and card animation to the memory
card. 4 images for CARD CHROMA, 2 images for CARD LUMINANCE, 2
images for CAMERA CHROMA and 4 images for CARD ANIMATION are
provided on the Canon DIGITAL VIDEO SOLUTION DISK.

1. In the camera window, click [UPLOAD].

2. Insert the DIGITAL VIDEO SOLUTION DISK to the computer’s
CD-ROM drive.

3. Double-click the CD-ROM icon, followed by the [DVC CARD
IMAGE] folder.
The folders [CARD CHROMA], [CARD LUMINANCE], [CAMERA CHROMA]
or [CARD ANIMATION] appear.
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4. Open the [CARD CHROMA], [CARD LUMINANCE], [CAMERA
CHROMA] or [CARD ANIMATION] folder, select the image
you wish to copy to the camcorder and click [Open].

5. Set [Image Size] to [Small].
• Confirm that your camcorder model name is displayed under [Camera

model].
• When you have selected multiple images in step 2, [Save subsequent

images with the same settings] will be activated. Click this button to
apply the current settings to subsequent images.

6. Click [Save to Camera].
• The selected images will be recorded to the memory card.
• When recording is complete, the images will appear in the Camera

Window.

Adding Still Images from Your Computer to the Memory Card
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Adding a Start-up Image to the Memory Card

Adding a Start-up Image to the Memory Card

❍ Image files that do not appear in the [Computer] list of the DVC My
Camera window cannot be saved to the camcorder.

❍ Do not detach the USB cable, turn the camcorder power off, or
disconnect the camcorder from the computer while the My Camera
Settings is being saved to the camcorder.

1. From the [Edit] menu in the Browser Window, select [My
Camera for Digital Video Cameras].
The DVC My Camera window appears.

2. Click [View Camera].
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Adding a Start-up Image to the Memory Card

3. Select the start-up image you wish to save to the memory
card from the [Computer] list and click the  button.
• The selected start-up image is displayed in the preview area to the right.
• The file name of the saved start-up image appears in the [Camera] list.
• Start-up images will be saved to the [Dcim] folder in the memory card.

4. Click [Close].
Follow the instructions in Customizing the Camcorder in the Camcorder
Instruction Manual and change the My Camera setting.
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Adding New Start-up Images to the DVC My Camera Window
Create a start-up image using an image editing application program. Create
the file in the JPEG format at a size of (w) 320 × (h) 240 pixels.

Once you have created the start-up image and saved it to the computer, use
the following procedures to add it to the DVC My Camera window.

1. Open the DVC My Camera window, and click [Add].

2. Select the file you created in the [Open file] dialog and click
[Open].
• The selected file appears in the [Computer] list.
• You can save the newly created file to the memory card using the

procedures described in Adding a Start-up Image to the Memory Card
(  95).

• To delete a start-up image, select it and click the [Delete] button.

The newly added data will 
appear here
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Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or
when reinstallation is required to fix corrupted files.

Uninstalling ImageBrowser and PhotoStitch
Move the program’s folder into the Trash to uninstall programs such as
ImageBrowser and PhotoStitch.

If the program folders contain subfolders into which still images/movies
have been saved, be careful not to accidentally delete those subfolders.
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Troubleshooting

This topic explains some of the causes for and solutions to problems with the
software.

? Cannot download images, camcorder is not recognized when the
camcorder is connected via the USB interface.

➜ Computer does not support the USB interface.
The USB interface is not supported for computers not in compliance with
the following requirements. Acquire the necessary system to use the USB
interface.
Requirements: Genuine Apple Computer brand computer with a built-in
USB interface.

➜ There is no memory card in the camcorder.
Insert a memory card into the camcorder.

➜ The camcorder is not set to the correct mode.
Slide the POWER switch to PLAY (VCR) and the TAPE/CARD switch to
CARD.

➜ Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer (  64) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

➜ If you are experiencing operational problems, detach the USB cable
from the camcorder and computer and terminate the connection.
Restart the computer and then reconnect the camcorder.

? Image files or folders do not appear in ImageBrowser.

➜ The image files may not be updated. In such case, click the [View]
menu and select [Refresh].
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